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Have I said yet, 
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Building Objects 
This section covers the objects found in a building such as walls, doors and the table with the computer 
on it. I do this because although there are some wide variations in many aspects of these objects, there 
are also some similarities in how they are added to the drawing, how they are controlled once in the 
drawing, and how their displays are controlled to get the final print to look like you want it. 

Basic Building Objects: 
• Walls: 
• Doors and Windows 
• Stairs and Railings 
• Roofs 
• Curtain Walls 
• Curtain Wall Units 
• Spaces and Space Boundaries 
• Structural Elements 

Intermediate/Advanced Objects: 
• Curtain Walls and Door/Window Assemblies 
• Mass Elements, Groups and Camera 
• Profiles 
• Slabs and Edges for Roof and Floor 
• Areas and Area Groups 
• Walls – Sweeps, Body Modifiers and Endcaps 

 
In this section, for each object: I break the subject matter objects down into four main categories of brain 
noise;  

• Basics --- Adding ---Modifying ---Etcetera 
The Basic section covers general thoughts and ideas about the object and includes a screen cap of the 
properties page, any tabs of the style sheet I think might be useful to point out, along with a couple screen 
caps of display representations that are may be unique for that object.  
 
In the Adding section, I discuss any parculiarities of the object in how it may be added or any cautions I 
have run across about doing the same.  
 
In the modifying section I break down into ACAD modify (grips, fillet trim etc.) and the Right Click tools 
unique to the object in question. Because you are working with ACAD, most ACAD commands work on all 
AECobjects. Some of this is common: 
Copy, paste etc. 
Ctrl-left drag to copy any object 
Right drag into new drawing while screen shows two open drawings 
Some of it differs from object to object 
Curtain walls will trim and break, but not fillet. 
Almost all the objects have different grip controls according to the needs/characteristics of the objects. 
 
The final section called Etcetera holds any thoughts that do not fit into the above categories 
 
Once again, these sections are not complete documentation by any means for the objects. The 
information I record here is mostly for you to use as a reference in the early phase of your learning curve. 
It also keeps me on track in the basic and intermediate class. 
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Walls, Walls, Walls and more walls 

Basics 
Know your walls, they are the crux of the production, everything else is icing on the cake. I have not 
really noted much here for the walls because we spend so much time on them in class. 

Properties 
 

Style 
Has components, endcaps, and display props 
“defaults” tab from R3 has moved to tool properties 

Display 

Adding 

Tool, RightClick > Apply to: 
Can convert plines/lines to walls – or can be used to “match Props” 

Pick points 
Watch the autosnap to baseline setting in the options. 

Other 

Modifying 

ACAD modifying 
Grips: Watch the autosnap to baseline setting in the options. 
Middle square grip will move entire wall,  - any attached walls will extend to the new location 
Triangular end grip stretches wall in line – no change in angle of wall 
Square end grips can pull wall out of plane (rotate). 
 
ACAD commands Trim, Fillet, Break, Extend etc all work with walls 
 

RightClick Tools 

Modifiers 
Modifiers = basic pier, nitch. Create as polyline and convert or, draw in place. Watch the Command 
line! 
When creating from polyline make sure the start and end point of the polyline are on the component 
you are adding the shape to.  
General Rule, keep your modifiers from crossing wall components with higher priorities – this will show 
the red circle of death. 
To remove a modifier – go to the modifier worksheet on the properties page for the wall. – you can 
also adjust various things like height in this worksheet. 
Modifiers can also be edited in place 

Interference 
Interference (will only be subtractive in model view, but can be subtractive in plan – only operates on 
shrinkwrap, so if shrinkwrap is not turned on in the style, you will not see interference conditions 
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Body Modifiers,  
make mass element, make bodymodifer – erase mass 

Sweeps 
Sweeps are an exception to the profile rules – insertion point is specific 
Sweeps will replace a component entirely with the geometry of the profile – if you need to change size of 
swept component, redefine the profile. 
outer sweep profiles drawn looking left (exterior brick mold etc), inner sweep profiles drawn pointing right 
(chair rail, crown mold etc). 
 

Roof line/floor line  
(P to Project to polyline, A to Autoproject to AEC object, R to reset – or edit in place) 

Etcetera 
Anatomy 
 

Components 
 

 Vertical data points:  
Floor line 
Baseline 
Base Height 
Roof line 
 

Cleanup 
 

Behavior 
Walls will attempt to clean up if the graph lines touch or cross.  
Walls will attempt to clean up if the Cleanup radius over ride of 
one wall touches or crosses the graph line of another wall.  
 

 Wall Cleanup Groups 
 

Endcaps 
 

Wall endcap styles 
Opening endcap styles 
See section that follows 

Modifiers 
 

Plan Modifiers 
Draw a polyline and convert it to a modifier (niche or pilaster) 
Right click to edit in place 
Do not try to force modifiers of a component with a higher priority 
(lower number) through component of a lower priority 
 
Body Modifiers – create a mass element or group. Replace, add 
to or subtract from a single component in the wall. 
 

Interference 
 

 

 
 
 

Wall  Component Index 
for all wall styles provided with the software. 
Concrete 200 
Concrete (Footing) 200 
CMU 300 
CMU Veneer 350 
Precast Panel 400 
Stud 500 
Insulation 600 (CMU/Brick, Stud/Brick) 



Building Objects 

© 2004 David D Driver.                                                     1/31/2008                                                            

Rigid Insulation 804 (Brick) 
Air Gap 700 
Air Gap (Brick Brick) 805 
Air Gap (CMU CMU) 305 
Air Gap (Stud Stud) 505 
Brick 800 
Brick Veneer 810 
Siding 900 
Metal Panel 1000 
Stucc1100 
Glass 1200 
GWB 1200 
GWB (X) 1200,1210,1220,1230 
Bulkhead 1800 
Casework - Base 2010 
Casework - Upper 2000 
Casework - Counter 2020 
Casework - Backsplash 2030 
Toilet Partition 3000 

Wall Endcaps 

Wall EndCaps Rules - Single component walls 

End caps General rules –  
 
When all else fails (or even before failure), recreate the condition by drawing the walls from left to right 
and go from there, drawing an endcap for the right end of the wall.  This eliminates as many variables as 
possible. 

Rules…. 
Polylines for end caps must be drawn counter clockwise. 
The Start and End point of the polylines must be co planar (aligned along the Y axis) 
The start and end points should be the same width apart as the wall you are going to apply it to, 
otherwise the endcap will be scaled to match the wall. Corollary: it is next to impossible to create one 
end cap for walls that have a variable width, unless all you are doing is creating a single element 
polylines and using an Offset 
 
Positive offsets will push the endcap into the wall (subtract from the length of the wall) 
Negative offsets will increase the length of the wall 
Think about a wall drawn from left to right, the positive/negative will be at the Origin of the wall, 
Negative is negative in the X direction, so the wall gets bigger. Go figure. 

Multiple component walls: 

Everything above applies. 
Before creating an endcap for a multiple component wall, look at the wall style and find out how many 
components it has and keep in your mind or write down which components are which.  You will be 
using the index numbers when you create the endcap, so you need to understand how the wall style is 
constructed before you create an endcap for it. 

One polyline per component. 
You may create a single polyline and apply it to a single component of a multiple component wall.  
Alternatively, you can create multiple polylines.  Each polyline will be assigned to a specific 
component. 

Endcaps to solve Cleanups 



Building Objects 

© 2004 David D Driver.                                                     1/31/2008                                                            

Just as sometimes there is no other way to clean up two walls other than making a special endcap for 
the situation at hand, so too are there situations where eliminating all the endcaps is the only option 
for cleaning up a wall intersection. 

Other notes: 
Endcaps may be applied by the wall style. 
Endcaps may be applied to an individual wall in the Wall Properties dialog box. 
Endcaps may be overridden at each end using the plan tools>override endcap 

 
Look at the samples that come with the sample wall styles, they will give you an idea of how to create the 
polylines for special conditions.  You can ‘insert endcap as polyline’ to dissect an endcap style. 
 

Of course this is much simpler in 2004/5, just draw a pline, select the wall, RC>Endcaps>Calculate 
automatically 

Opening Endcap Styles 
 
wall endcaps are 3D for openings, as well as they are nested. 
Start with a basic endcap knowledge, and then you can create endcaps for each of the 4 sides of a 
window. Once the 4 endcaps are made (if different you will have 4, you gather them together in a Wall 
Opening Endcap Style to assign to the wall style). 

Remember to turn on the 3D endcap in the Model representation of the wall style or 
drawing default if you want to see them… 

Workaround for projecting wall to stair 
Solution: The auto-project option of the Roof Line routine only holds in memory the current object to 
which the wall is projected. If the object selected as the projection point contains varying heights, the 
results are not as expected. Use the following procedure to avoid this problem:  
This procedure is also needed to raise the top of a curved wall to a curved stair. 

1) Use the BREAK command to segment the wall object into multiple sections with a length equal to 
each depth of each step in the stair run.  
2) From the Design menu, choose Walls > Wall Tools > Roof Line.  
3) On the command line, type a for the Auto-Project option and press ENTER.  
4) Select each of the segmented wall objects when prompted to Select walls and press ENTER.  
5) Select the stair object when prompted to Select entities and press ENTER twice.  
6) From the Design menu, choose Walls > Wall Tools > Join Walls.  
7) Select one of the wall objects when prompted to Select first wall.  
8) Select an adjacent wall object when prompted to Select second wall.  
9) Repeat steps 7 and 8 as many times as necessary to join each of the segmented wall objects into a 
single wall object. 
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Doors, Windows and Openings 

Basics 

  

Properties 
Properties are mostly about size, 
head height, sill height, etc 

Width/height of doors are 
measured to the inside of the frame 
and windows to the outside of 
frame (by default) – this is set in the 
properties page of tool or object 
(use to be in options R1-3) 

 
 

 
 

Style 
Most variables held in style (how 
the door /window /opening will be 
built in the real world) 

Door and window styles have the 
same control 

 

Dimension tab controls frame, stop 
and width 

 

Third tab controls shape and type – 
Use Profiles for custom shapes of 
doors, windows or openings. 

Void in profile will automatically be 
calculated as glass in door, solid in 
window or opening 

 

 

 

 

Display 
Doors and windows have Elevation 
and Sill Representations in addition 
to others 
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Display Rep Plan 
2004  added quite a few 
components to the plan rep. This 
allows you a lot more control in 
RCP’s and when the wall is in a 
curtain wall or assembly 

  

Display Rep Threshold 
Although the Threshold 
representation is active (turned on) 
for many on the plan display 
configs, interestingly the objects in 
the rep are turned off by default. 

Just turn on the components to see 
the sill in plan 

 

Display Rep Elevation 
Note the elevation rep is completely 
separate from the model rep. 

The Elevation representation is 
used in the sections and elevations. 

 
 

Adding 

Tool, RightClick > Apply to: 
Existing door only (match props of existing door to tool properties) 

Pick points 
Pick a wall, pick a point to place the door/window/opening 
If you press Enter before selecting a wall it will just place door in the drawing without anchoring it to 
anything 
Add Property Settings/ Default tool props: Watch the setting Position Along Wall on the properties. 
Unconstrained lets you add anywhere in the wall, Offset/Center just sticks to the values you enter 
there. 
Specific distance: Once wall is picked, but before placement, use the tab key to cycle through the 
dimension values that appear after you pick the wall. Type in value needed. 

Other 
Wall, Select, RC>Insert>door 
Add selected works for doors and windows (select one in the drawing, Right Click > Add selected). 
This is useful for adding in windows you have customized the location of (within the wall) or layer of 
(will put new door/window on same layer) 
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Modifying 

ACAD modifying 
Three grips 
Triangles at bottom change width of door, triangle at top changes height 
Square moves door as is 
Arrows flip door. 

RightClick Tools 

Add profile or edit profile in place 
Add a profile or edit it in place is that not clear? 
The profile is used in the style of the door to determine its shape as well as if there is glass in it or not. 
– refer to the door shape in its style 

Reposition along wall 
Select inside frame or center of door 
Select point to measure from 
Type in distance between those to points 

Reposition within wall 
Select outside of frame or center of door 
Select point to measure to (perp to wall) 
Enter distance on keyboard 

Etcetera 

Muntins 
Located in the elevation and model display properties you will find a muntins tab. 
Windows had Muntins in R3, new to 2004/5, doors have muntins, but the interface is a bit wonky. – 
you may not get a preview image, but the muntins will be applied if the door has a glass component 
(custom profile shape). 
If you apply muntins to the elevation representation, you must also apply them to the model rep. 

Openings 
Openings are added just like a door or window.  
Openings are one of the few ADT objects that are not style based. This means that if you create one in 
the drawing and modify its display properties, just use add selected to add more openings that look 
like the one you created. 
While you are trying to get the opening to look like you want it to for your CD’s, don’t forget that it has 
a different sill representation separate from the plan representation and you can use both of these to 
get what you want. 

Gothchas 
Check you vertical alignment (properties page) is set to threshold for door and head for window 
The muntins must be adjusted for each of the display reps you are going to use 

My arched door looks like a stop sign… 
AECFACETDEV: (Facetdev (ADT3)) (on the Options, AEC Object Settings tab 2004/5) 
Variable from 0 to 1 Controls tessellation of curved walls 
I.e. 1/8 = more segments than ¾. Set at ½ by default, this value seems to me to be a bit too large.  If you 
present Demo’s, you might want to reset this in your demo sets.  This affects a whole lot of things with 
curves such as the circle of a plan view of a column, and curved profiles set as a shape of a window or 
custom door. 
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Advanced  

Creating a panel door 
This article is from the knowledge base Date Revised: 08/30/1999 Solution ID: TS38774, but still valid in 
ADT 04/05/06 (different interface, but generally same process) 
Problem:AutoCAD Architectural Desktop 2.0 does not provide panel doors or explain how to create them.  
(Same as 04/05/06 – read on…) 
Solution:AutoCAD Architectural Desktop 2.0 includes several features to enhance the creation of doors 
and windows. One of these new features is the ability to attach a custom block to the different view 
representations of doors. 
OK this has been around for a long time, but it is the same process you can add a custom block to a 
railing, window, curtain wall etc..I have rewritten this for 04/05/06 because of the interface change you will 
be getting things from different places. 
To do this, create an AutoCAD block of a single panel, and apply that block to a custom door created 
from a profile. 

1) The first thing you need to do is create a new door style: 
2) Open the Doors - Custom (Imperial) drawing from the content folder.   
3) In the Style Manager select Door Styles. 
4) Choose the New button. Enter a name for the new door style, then double click the name to edit the 
new style.  
5) Select the Design Rules tab, enable the Custom Shape setting and select the Panel door shape, 
which was created in the drawing as a profile. (To see what the Panel door shape looks like, select Insert 
Profile as Polyline from the Format pull-down menu, then insert the Panel door shape.) 
6) Choose OK until all dialog boxes are closed. 
7) In the drawing, insert the new door into a wall. Note that although the door appears to have panels; 
they are not three-dimensional. 
8) Now that the door style is created, perform these steps: 
9) Right click on the door, and select Entity Display. 
10) Select the Door Property Source and select Attach Override and Edit Display props. 
11) Select the Other tab from the Entity Properties dialog box. 
12) Choose the Add button to access the Custom Block dialog box.  
13) Choose the Select Block button and attach the Aec_Door_Panel block. 
14) Select the appropriate check boxes to Scale To Fit for the Width, Depth, and Height. 
15) For the insertion point, choose Center for the X value, Front for the Y value, and Bottom for the Z 
value.  
16) (The insertion point is the point that the block will be inserted in respect to the door itself. If you 
insert the block into the drawing, you will notice that the insertion point of the block is in the center of the block 
and located at the bottom of the block.)  
17) Choose the Glass Component for the Component type. Do not change the default setting for "All 
Selected". (If you select the Single option, the number will be listed as the default. This number corresponds to 
the number of voids created from the AEC Profile, which will result in this door having six different 
components set up.) 
18) Choose OK to return to the drawing. 
19)  The new panel door is now created. 

Creating custom door and window frames  
Date Revised: 10/07/1999 Solution ID: TS41955 
Problem: All door styles and window styles utilize the same default frame design. 
Solution: You can create custom door frames and window frames. 
This one is the same as the last one but different – manipulates the frame – I have not revised this - ddd 

1) Set the current layer to 0. 
2) Create the desired frame trim shape as a closed polyline. 
3) Enter ROTATE3D on the command line. 
4) Select the polyline of the frame trim shape and press ENTER. 
5) Enter X on the command line and press ENTER. 
6) Select a point on the block when prompted to specify a point on the X axis. 
7) Enter 90 on the command line and press ENTER. 
8) Create a polyline with the appropriate dimensions and shape for your frame object. 
9) Move the polyline of the frame trim shape to one end of the polyline that represents the door or 
window object. 
10) From the Draw menu, select Solids  Extrude. 
11) Select the polyline of the frame trim shape and press ENTER. 
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12) Enter P on the command line and press ENTER. 
13) Select the polyline representing the door or window object as the extrusion path. 
14) Enter ROTATE3D on the command line. 
15) Select the extruded 3D solid and press ENTER. 
16) Enter X on the command line and press ENTER. 
17) Select one end of the extruded 3D solid when prompted to specify a point on the X axis. 
18) Enter 90 on the command line and press ENTER. 
19) From the Draw menu, select Block  Make. 
20) Create a block from the extruded 3D solid. 
21) Select the door to be modified, right-click and choose Entity Display from the shortcut menu. Select 
the Display Props tab. 
22) Applying the custom frame for the Model Display Representation: 
23) Set the Display Representation field to Model. 
24) Select Door as the Property Source. This will apply the custom frame to this single door object. If 
you want the custom frame to be applied to all doors of the same style, select Door Style.  
25) If you want the custom frame to be applied to all doors, select System Default. 
26) Choose Attach Override and choose Edit Display Props. 
27) Select the Other tab and choose Add, Choose Select Block, select the block created from the 
extruded 3D solid, and choose OK. 
28) Select the Scale to Fit options for width, height and depth. You might also need to modify the 
Insertion Point and Insertion Offset settings depending on the insertion point for the original block and the 
desired results. 
29) Verify that the Component is set to Frame Component and that the Outside option is selected and 
choose OK. 
30) Select the Layer/Color/Linetype tab. 
31) Select the Frame component and turn off its visibility. There are two Frame components listed in 
this area. Turn off the visibility of the Frame that is the second component in the list. Choose OK. 
32) Applying the custom frame for the Plan Display Representation: 
33) Set the Display Representation field to Plan. 
34) Repeat steps 2 through 10 of the preceding procedure, "Applying the custom frame for the Model 
Display Representation.”  Choose OK. 
35) Note: It may be necessary to turn off the visibility of Stop component in addition to the Frame 
component depending on the custom shape utilized. If you are extruding a frame trim shape for a window, 
start the extrusion from a mid-point of the polyline to achieve the best results. Starting the extrusion from an 
end point can cause problems with the final results. 

Adding handles to doors 
Date Revised: 08/17/1999 Solution ID: TS38641 
Problem: AutoCAD Architectural Desktop 2.0 includes several features to enhance the creation of doors 
and windows. One of these new features is the ability to attach a custom block to the different view 
representations of doors. 
Solution: 

1) Create an AutoCAD block that represents a door handle.  
2) Draw a standard wall and insert a standard door. 
3) Change the view of the drawing to a model view. 
4) Right-click on the door and select Entity Display. 
5) Select the Display Props tab. 
6) Highlight the Door Property Source, select Attach Override, then Edit Display Props. 
7) Select the Other tab, then choose the Add button to attach a block.  
8) Choose the Select Block button and choose the block that represents the door handle (step 1). 
9) Enter values that represent the location of the door handle. For example, if you look at a door  
10) that has a handle on the left, use the following values.  
11) (Note: The values entered will be different depending on the insertion point of the block and the 
swing location of the door.) 
12) If the door handle is 3" over from the left of the door, select Left for the X position and 3" for the 
Insertion Offset. 
13) Select Front for the Y value, and enter 0" for the Insertion Offset. This is based on the door handle 
block's insertion point located in the center and the back of the handle). 
14) The door handle will be 3'-0" from the bottom of the door, therefore select Bottom from the Z 
Insertion Point, and enter 3' for the Z Insertion Offset value. 
15)  After you have entered the appropriate values, choose OK to return to the drawing.  

16) To attach a handle on the other side: Repeat steps 4 through 9. Be sure to select the check box 
to mirror the handle in the Y direction, then choose OK to return to the drawing. 
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Multi View and Masking Blocks 

Basics 
Most of the content in the DesignCenter’s Design folder are MultiView or MvBlocks 

 

Properties 
Not a whole lot here 

 
 

Definition 
The MultiView Block definition is its 
style. This is where standard ACAD 
blocks are assigned to each view 
direction for each Display 
representation 

 

 
Display 

MvBlocks don’t use the standard 
display mechanism quite– it is all 
stored in the MvBlock definition. 
The display system calls a 
representation from the block, but it 
is the block definition that controls 
what happens at that point 

Adding 
Drag and drop from DesignCenter 
Drag from Design Center to the Palette and add from there. 
Insert > MvBlock if definition exists in drawing. 

Tool, RightClick > Apply to: 
Not available 



Building Objects 

© 2004 David D Driver.                                                     1/31/2008                                                            

Pick points 
Placing the MvBlock is different from Design Center than palette. If you drag from the DesignCenter 
where you let up on the left mouse button is where the block is inserted. You get a bit more control if you 
drag the block to a palette 

Modifying Attributes 
If you have a MvBlock that has attributes (standard elevation or section bubble in ADT – the one without 
the page ref) select it and go to the properties page and pick the attributes worksheet. 

Gotcha’s 
You drag a switch to the plan view and it shows up – by the way, switches and recepts use the drawing 
and annotation scale like a door tag. Everything is groovy. 
You drag a light fixture to the plan view of the drawing and it does not show up. 
You change the display configuration to Reflected and the light shows up, but the switch disappears. 
Edit the multiview block definitions – Add the plan view (ACAD) block to the reflected display of the 
switch, to have it show up in both the floor plan and the RCP. 

Etcetera 
Because the MvBlock definition holds several standard ACAD block definitions, you cannot purge these 
ACAD block definitions until you purge the MvBlock style. 
 
NEVER turn off/freeze layer 0 – if all of your MvBlocks disappear at once – it is probably because layer 0 
is turned off. Most of the content has the sub dependent view blocks defined on layer 0 with visibility set 
to ByBlock. 
 
Another old tech support issue from the older knowledge base that is still valid 
Issue: Multi-view blocks, such as electrical fixtures are not visible in a plan view.  
Solution 

These steps illustrate an example for modifying representation sets: 
1. Create a new drawing using the A-Design-Model template. 
2. Use the Zoom Window command to zoom into the center square (numbered 5 in the upper right 
corner of the viewport). 
3. Enter MS on the command line to change from paper space to model space. 
4. Select the Plan viewport as the current viewport. 
5. Access the Electrical Fixtures command (Design > DesignPart Library > Electrical Fixtures). 6.
 Select "2X4 Emergency" from the available palette, then choose OK. 
7. Press ENTER to accept 0 as the default rotation angle. 
8. When prompted to Select Object To Mask, press ENTER. 
9. Press ENTER twice more. The symbol will be inserted.  You will only see the 2X4 Emergency 
symbol in the model viewport.  The default representation set for this view does not display these blocks. 
10. Select the Plan viewport to make it current. 
11. To check the display configuration for the plan viewport, select the Select Viewport Display 
command in the Desktop pull-down menu. The Viewport Display Configuration dialog box will display. 
12. The display configuration for the plan viewport will be highlighted. In this case, the display 
configuration is Work. Choose OK to exit this dialog box. 
13. Use the Edit Display Configurations command (Desktop > Display Control > Edit Display 
Configurations), highlight Work, then choose the Edit button. 
14. Select the Configuration tab. Notice in the "View Direction Dependent Display Configuration" 
section a detailed list of the View Set  used for each View Direction.  For this example, the top view is uses the 
Work_Plan View Set. Choose OK the next two dialog boxes to exit to the command line. 
15. Use the Edit Representation Sets command (Desktop > Display Control > Edit Representation 
Sets), then highlight the Work_Plan representation set and choose Edit. 
16. Select either of the Display Control tabs to view the components that are currently enabled in the 
representation set. You can modify these settings as desired.  In this case, the "Multi-View Block Reference -- 
(Reflected)" needs to be enabled in order to view the 2X4 Emergency in plan view.   
17. Enter RE for regen on the command line to refresh the display.Note: Although this example uses 
an electrical fixture and the Work_Plan view, the same principle is true for all representation sets and 
Architectural Desktop components. 
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Profiles 

Basics 
The basic way to input a custom shape into a style. Can be used to create custom shapes for: 
Doors, windows, openings, railing components (any of them) wall sweeps, roof fascias and soffits, slab 
edges, extruded mass elements, rotated mass elements and more 
Will only exist in the style manager, never in the drawing as a “Profile” 
Remember proper drawing etiquette when creating pline; No overlapping lines, No zero length 
segments 
Can be multiple closed polylines  

Definition 
A profile definition is just the geometry pulled from a closed polyline. 

Creating 
Draw a CLOSED polyline, RC> convert to > Profile definition (works on multiple Plines) 
Or  
Create a new definition in the style manager right click on the new definition and pick Set From to put you 
in the drawing to pick an existing polyline. (or several), pick an insertion point 

Modifying 
Because it does not exist in the drawing, modifying consists of creating a new polyline and overritting the 
existing definition. 
If you want to modify a profile definition, use the Format >Profiles > Insert Profile as Polyline. Make the 
modifications to the polylines and then overwrite the definition with the new geometry. (style manager set 
from or RC>convert to Profile definition) 

Etcetera 
Almost all profiles are ok with centroid as insertion point. Exceptions to this are profiles created for: 

Wall sweeps 
Slab edge styles and roof slab edge styles 

The command line prompts that you get with the RC > Convert to >profile are a little different than if 
you use the style manager RC > Set From. But the results can be the same. 
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Roofs 

Basics 
A shed roof is nothing more than a roof with three sides “Edit Edges” and change slope to 90. 
Generate low slope roofs that are within parapeted walls from polyline created within wall boundaries. 
A roof behaves like a closed polyline 
Go as far as you can with a roof before converting it to a roof slab, and then only if you really need to. 

Properties 
Edge control  

Style 

Display 

Adding 

Tool, RightClick > Apply to: 

Pick points 

Other 

Modifying 

ACAD modifying 

RightClick Tools 

Etcetera  
Mysterious/Dangerous 
Roofs have no true plan rep. and as such need to be flattened to Z=0 in consultant drawings 
!!!Watch your snaps around roofs and roof slabs!!! 

A flat (shed) roof is a roof with 3 edges at 90 degrees. 
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Spaces, Zones, Space Boundaries and Room Tags 

Spaces One Sheet: 

Spaces 
The Space object in ADT is the basic object to represent an area or volume such as a room or building in 
a master plan. There are many different things you can do with a space. There are also may ADT objects 
that are directly related to spaces.  

Zones 
A Zone in ADT most simply put is a collection of spaces. Where a space can report its area, perimeter or 
volume to the properties page or into a schedule, a Zone can report this same information about a 
collection of spaces. A commercial example would be BOMA calc’s where the all of the stairs and 
elevators though separate space objects would be reported as vertical circulation. A residential example 
would be all the conditioned areas reported out as the liveable area of the house. 

Space Boundaries 
A Space Boundary is a wall like object that surrounds a space. More used in versions prior to ADT 2007, 
it can still be used in space planning as an approximation of a wall. You can add doors and windows to a 
space boundary and also convert it to a wall, but it cannot have sub components such as gwb and studs 
as a wall can. With the release of 2007, walls themselves can act as bound of a space and the space 
itself can update as the deisgn changes 

Room Tags 
A Space is an ADT object with a floor and ceiling. 
By default in plan view it is drawn with a hatch. 
Spaces are style based and the style controls: 

• Generally what the hatch looks like 
•  

 

Basics Spaces 
A floor and a ceiling, plus the space above the ceiling 
Has its own query function to find square footage by style (only available from the design pulldown 
Useful for space planning, Project program writing,  
Mysterious or just disconcerting: Floor will always extend below world UCS 
Can be used as clipping plane for ceiling grids 
Cntl-shift to duplicate space boundaries 
Troublesome: When you are doing room schedules, it wants to look for the room tags When you place 
a room tag, it wants to attach itself to a space object. See Etcetera 
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Properties 

Style 

Display 

Adding 

Tool, RightClick > Apply to: 

Pick points 

Other 

Modifying 

ACAD modifying 

RightClick Tools 

Space Boundaries 
Outside In from slices (mass of the building determine the shape of the space, space is this divided) 
Inside Out from spaces (Spaces representing rooms are creating, then grouped together and used to 
generate boundaries. 
Boundaries generated from spaces get their width from the space style net to gross, but their height 
from the space properties 

Room Tags 

Etcetera 

Creating a single wall between adjacent Space boundaries  
Date Revised: 07/09/1999  Solution ID: TS18813 
Problem: When you generate walls from two adjacent space boundaries, the common edge is drawn as 
two separate walls (rather than as one wall). 
Solution: To create a single wall between Space boundaries: 

1) Select the Concept menu > Space Planning > Add Spaces.  
2) Insert two rectangular spaces so that they share a common edge. 
3) Right-click on one of the rectangular spaces and select Edit Space Style.  
4) Select the Dimensions tab and set the Net to Gross Offset value to 0". 
5) Repeat steps 3 and 4 for the other rectangular Space. 
6) Select the Concept menu > Blocking and Boundaries > Convert to Boundary > Convert from 
Spaces. When prompted to select Spaces, select the rectangular Spaces you inserted in step 2. 
7) Right-click on the Space Boundary and select Boundary properties. 
8) Select the Dimensions tab. Choose Solid Form for the Segment Type and set the width to  
9) the desired wall width. Choose OK. 
10) Right-click on the Space Boundary and select Generate Walls. 
11) The adjacent edges will form a single wall. 
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Stairs 

Basics 
For multistory buildings with even number of risers, use ‘multi-landing’ stair to avoid goosenecks  
U shaped stair cannot have top riser expanding past the bottom riser – use multilanding stair instead 
Can be converted from plines (does not do curves, see etcetera below) 

 

Properties 
Shape determines pick points 
when adding 

Vertical Orientation: what is 
first pick point – top or bottom 
of stair 

Calculation Rules: Use to 
“Unlock” stair length, riser 
count, riser or tread values. 

Interference – used for spaces 

 

 

Style 
Stair styles hold code limits – 
change for residential stairs 

Landing Extensions – 
determine railing extension 
past bottom riser if not set in 
railing style. 

Also control Phantom or Ghost 
tread for stair. 
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Display Rep Plan 
 

Control the 
Layer/Color/Linetype of each 
component above and below 
the cut line separately. 

Use Display control to create 
‘bottom floor’ and ‘top floor’ stairs: 
Bottom floor stairs have all “Down” 
Plan components Hidden 2 and 
grey.  

Control the cut plane and 
arrow as well as the type of 
break mark on the “Other tab” 

 

 
Display Rep Model 
 

For your top floor stair, turn off 
all the model components  

Top Floor Stairs have all model 
components turned off so you 
do not see a stair going 
through the top of the building 
section or elevation 

Adding 

Tool, RightClick > Apply to:  
Only Stairs – see note on StairConvert below 

Pick points 
Points picked are determined by shape of stair in the properties box. Each stair has different set of pick 
points – straight run and multi landing both alternate between adding landings and adding stair runs until 
the stair is complete. U-shape stair just gets bottom and top of stair – two picks 
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Other 

Modifying 

ACAD modifying 
Shift, Alt do different things on grip stretch 

RightClick Tools 

Etcetera 
StairConvert at the command line will convert a polyline to a stair – I have not seen a tool to do this, and 
right click apply tool properties to does not have polyline as option. 
 
No custom blocks assigned to display – assign custom blocks to railing and attach railing – turn off stair 
model display if needed. 

 
R3 and previous problem: By default, stairs are represented as a whole object, and the Cut Plane 
Height rules that apply to the walls do not apply to stairs. 

Solution: Note: In Plan View, the representation of the stair should show only its bottom portion, or the portion 
below the Cut Plane Height. In some instances, the cut height of the stair will not coincide with the Cut Plane 
Height setting for the walls within the same project. 
1) Draw a stair.  While in Plan View, right-click, then select Entity Display. 
2) Select the Display Props tab, and choose one of the following options as needed: Stair, Stair Style, 
System Default. 
3) Choose Edit Display Props, then select the Other tab. 
4) Change the following options: 
5) Cut Plane Elevation - the cut plane height of the stair, that is, the height at which the stair will be 
interrupted. The default value is 3' 6" to match the Cut Plane Height default value of Wall Objects. 
6) Cut Plane Distance - the distance within the above interruption - in case the stair is to be displayed 
above and below the Cut Plane. The default distance is set to 9" to match the distance assigned to the Cut 
Plane Distance default for railings. 
7) Cut Plane Angle - the angle used when generating the interruption. The default value is 25. 
8) Select the Layer/Color/Linetype tab. 
9) Turn off one, some, or all of the following options as desired: Stringer Up / Down, Riser Up / Down, 
Nosing Up / Down, Path Up / Down and Outline Up / Down. 
Notes: The Up and Down settings use the orientation of the directional arrow on the stair. For example, when 
you turn off the Down options, only the upper portion of the stair is displayed. 
Note: It is advisable that the Cut Plane Elevation, Distance, and Angle of the stair match the same settings for 
the railings attached to the stair. 
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Curtain Walls and Door/Window Assemblies 
Terminology 

 
 
 
There are three objects in ADT that all use the same interface but behave a bit 
differently:  Curtain Walls, Curtain Wall Units and Door/Window Assemblies.  
Each of these objects uses the same style dialog boxes to create and 
manipulate their styles. The differences in these are:   

• Curtain Walls stand alone and can have Curtain Wall Units assigned as an 
infill panel 

• Curtain wall units cannot have styles as infills.  These are assigned within a 
curtail wall – to perhaps fill in for an entire floor 

• Window assemblies break a hole in the wall and become anchored to the 
wall like a single door or window. 

Regardless, all of these styles have the same interface when it comes time to 
edit their styles. This interface can be daunting until you realize there is a 
method to the madness. This chapter introduces you to the KIT of PARTS and 
SET of RULES that organizes the madness into a system that is 
understandable. 
 

Kit of Parts and Set of Rules 
I like to think of window assemblies, curtain walls and curtain wall units as a kit of parts and a set of rules. 
Both of these are accessed from the Design Rules tab of the style. The Kit of parts consists of  the 
Element definitions (on the left) and the Set of Rules is where you assign this kit of parts to the style (in 
the right pane of the dbox). 

Kit of Parts: Four parts 

 
Divisions are how the grids within a curtain wall are established.   
Infills are what happens within a grid 
Frames wrap around each grid 
Mullions happen at each grid line 

Mullions and Frames 
Frames are around the outside of a grid. A mullion is placed at each grid spacing 
Mullions and frames basically have the 
same control. 
Width – think of a frame running vertically 
and you are looking at it from the front. 
Width will be how wide the fame or mullion 
is. Depth is the thickness in the wall 
Offsets:  Again, think of a wall drawn from 
left to right – X offset will shift left and right, 
Y will  shift in the depth of the wall 
Use Profile: - any shape you can draw as a 
closed pline, you can make into a profile and 
use as a frame or a mullion. 
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Divisions 
Divisions establish how often the grid is broken up. 

 
Fixed Cell dimension (every thirteen feet) 
Fixed number of cells (make it three divisions no matter how high it gets) 
Manual (Absolutely make a division 15’ above the baseline, 27’ above the baseline etc) 
BaseLine/BaseHeight 
Also here is the AutoAdjust Cells where you specify what happens if the dimensions of the grid fall in 
between grid lines 

Infills – what happens inside the Grid 
 
 
 
 
 
 
 
 

You can get creative with simple panel infills – a stone panel may be an infill that is 8 inches thick, the 
mortar joint a mullion that is ½ inch x 7.5 inches 
You can use a style as an infill – doors and windows – the window or door will fill up the “cell” it is 
assigned to. 

Nesting Grids 
OK, that is the kit of parts…where it gets complex is when you have a grid nested inside another grid, 
which brings us to…  
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The Set of Rules! 

 
 
 
 
 
At the upper left is the Grid Tree that displays the grid 
arrangement = WHICH GRID (as you pick different grids at the 
upper left, you see a new arrangement on the right) 
On the right is where you assign the kit of parts to the grids.  
The first column “Name” tells you What Part (element) you are 
working with.  The second column shows what definition is 
assigned to this grid.  Although the pull down arrows do not 
show normally if you pick in the element area you get a pull 
down as shown above to choose the element definition. The 
third column “Type” is Where you want the element placed in 
relationship to the grid.   Do you want this one infill placed by 
location (start, Middle, end) or by Index number (proceeding 
from start to end, on bay numbers 1,3,5) 
In the illustration at the right, the infill for the primary (grid1)grid is 
a nested grid – instead of putting an infill in the ‘cell’, we put a 
grid inside the cell. 
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Curtain Walls 

Basics 
Too complex for their own good, there is a method to their madness, or you may apply your own 
madness methodically and get good results 

 

Properties 
Not much to the 
properties, just height, 
width, end miters that 
are easier to do with the 
set miter angles from 
the right click menu. 

Style 
Everything is in the style 
– see separate handout 
on curtain walls and 
window assemblies. 

 

 

Display Plan 
Not too many surprises, 
Add ACAD blocks: 

to add to  

or replace components 
in the style 

in the Custom Plan 
Components of the Plan 
Representation 

 

Cut plane is hold over 
from pre 04/05/06 Now 
use the display config to 
set this kind of cut plane 

Display Model 
Use the Other tab to 
assign custom blocks in 
model view 

Adding 
Pick Points 
Added like a wall, two pick points  
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No justification, always center line 

Tool, RightClick > Apply to: 

Curtain Wall 
Use to apply current TOOL PROPERTIES to an existing curtain wall (a kind of match props) 

Wall 
Use to convert a wall to a curtain wall 

Layout Grid 
Create layout grid in elevation (old R2/R3 trick). This will take layout and transfer it to a curtain wall. If 
you have doors or windows anchored to the grid, they will be deleted with the layout grid. 

Reference Curve 
No curve in adding, but you can RC>apply to>referenced base curve and pick arcs or plines with 
curves. 
Length of curtain wall linked to curve (line) 

Elevation Sketch 
Converts linework drawn in elevation, to curtain wall style – enters edit in place mode, remember to 
save these changes back to style and save to a new style 

Pick points 
Just like a wall without justification (always drawn at ‘centerline’ ) 

Other 

Modifying 

ACAD modifying 
Extend, Break and Trim work 
Fillet does not. 

RightClick Tools 

Design Rules, (like edit in place) 

Transfer to object 
Puts the design rules on the objects (don’t use style when in this mode) 
Use for applying overrides that you want to eventually write back to the style 
When done overriding, use… 

Design Rules, Save to style 
Only available if Transfer to Object has been activated. 

Component tools; Infill, Frame/Mullion, Division  
Use to override existing parts of the curtain wall in the drawing 

Infill- Show Cells 
Displays cell marker so you can select them to merge or override 

Merge 
Combine two cells together 
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Override - infill, Frame/Mullion or division 
Apply new definition to existing parts of the curtain wall. The new definition MUST exist in the style 
definition before you do this. 

Frame/Mullion Add Profile 
Adds profile definition so you can use it to replace standard rectangle shape 

Roof/Floor line  
Just like a wall, A to autoproject to an AEC object, P to project to polyline. Or edit in place. When you 
edit in place the right click menu changes (add vertex etc) 

Interference 
Cheap way to add a window assembly.  
Show markers, merge cells, override bottom frame, add window assembly to drawing (not to a wall). 
Move it into position and apply it as interference to the curtain wall. 

Etcetera 
Curtain Walls can have styles as infills (AEC Polygon, door style, window style, curtain wall assembly 
style (a “nested” curtain wall) 
Easiest way to create front entry is to apply Door Window Assembly as override. Door Window 
Assembly must exist in the curtain wall style as an infill definition. 
When you convert from linework, frames will be outside justified, mullions will be center justified – see 
handout for exercise on how to fix this. 
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Door/Window Assemblies 

Basics 
See complete handout for in depth coverage 

Properties 
Properties are mostly about size, 
head height, sill height, etc 

Depending on the Style of the 
Assembly, it may or may not adjust 
to different widths and heights well. 

Style 
Style controls behavior of the 
assembly as it grows 

Almost everything is here in the 
Design Rules tab. 

Create the Element Definitions first 
and then assign them to their place 
in the grid or nested grid 

Display 
Assemblies do not have an 
Elevation representation, but do 
have a sill plan 

 
Display Rep Plan Cut Plane 

Use the Plan representation 
override cut plane to assign an 
override to the style 
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Adding 

Pick points 
Pick wall to place assembly in, pick position for assembly. Same as door, use tab key to cycle through 
visible dim values when placing,  

Tool, RightClick > Apply to: 

Door / Window Assembly 
Apply the Tools Properties to another Assembly 

Doors, Windows and Openings 
Converts a door or window or opening to an assembly. This just applies the tool properties to the object. 
Original width is discarded. 

Layout Grid 
Same as a curtain wall. Create layout grid in elevation (old R2 trick). This will take layout and transfer 
it to a curtain wall. If you have doors or windows anchored to the grid, they will be deleted with the 
layout grid. 

Elevation Sketch 
Converts linework drawn in elevation, to Assembly style – enters edit in place mode, remember to 
save these changes back to style and save to a new style. 

Other 
Watch the insertion set to Sill/head for a window assembly – if the assembly goes through the bottom of 
the wall, the default is set to place the assembly by the head height 

Modifying 

ACAD modifying 
Grip stretch same as doors 

RightClick Tools 
You get the same right click controls on a window assembly that are described for a curtain wall. These 
allow you to override a cell, frame, mullion or division 
Etcetera 
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Created for the intermediate class, his chapter has two different exercises.  
 

 
This first exercise shows how to create a window assembly from scratch using the style interface. This 
exercise puts together a window assembly that looks like the image above. 
 
 
 

 
The second exercise outlines how to create a window assembly from lines, and then create new infill and 
mullion assignments with overrides.  
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Creating a Simple Style Based Window Assembly 
Exercise overview.  In this lesson we will create a window assembly that has a door in the middle, a 
sidelight with a kick plate at the bottom. 
Process 

• Create and edit new Style,  
• Create kit of parts, divisions, Infills, Frames and Mullions you will need for the window assembly 
• assign these parts to the grid, create new nested grids as needed 

GO… 

Create a and edit a new Window Assembly style 
Start with the AEC_Arch imperial int’l Template 
Design>Window Assembly>Window Assembly Styles 
New icon, rename to 01Class, RC>edit 

Create the Kit of Parts  

Create the Divisions.   
We will need a division to create the transom, a division to separate the door from the sidelight and a 
division to separate the kick plate. 

 
1. On the left under Element Definitions, highlight divisions,  
2. Pick the new icon 
3. Rename to Transom 
4. Pick horizontal orientation 
5. Change division type to manual 
6. Pick ADD gridline icon 
7. Change offset to 7’1 (to go into middle of 2” mullion – later) 
8. Choose from grid bottom 

Repeat 2-8 adding two more divisions 
Name  = DoorWindow, orientation = Vertical: Division type = Fixed Cell dimension = 3’-2” (no offsets) 
Name = KickPlateDiv = Horizontal, Manual, 18” above grid bottom. Pick AutoAdjust right side shrink 
Drawing at this point is saved in the lesson folder as WindowAssemblySimpleD2.dwg 

Create Infills 
We need three infill definitions, but only need to create 2, we will use the default infill for all the glass, so 
be sure not to change it.  We will need to make a door infill and a kickplate infill. 
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1. On the left under Element Definitions, highlight Infills.  
2. Pick the new Infill icon 
3. Rename to Door 
4. Use the dropdown to change infill from simple panel to style 
5. Pick the small plus box to expand the door styles 
6. Highlight Hinged – Single Full Lite 

Repeat 2-6 adding one more infill 
Name  = KickPlateInfill;  Infill type = Simple Panel;  Panel thickness = 3 

Create Frames and mullions 
We do not need to create any frames, but we should just change the default to 2” wide and 6” thick for 
both the default mullion and the default frame.  You can make a frame or mullion for a threshold if you 
want to, see the next exercise on how to do this 

1. On the left under Element Definitions, highlight Frames  
2. Change the width to 2” leave the depth at 6” 

Repeat these sizes for the mullions. 
Drawing is saved as WindowAssemblySimpleD3.dwg 
Pick OK and OK and save this drawing at this point. 
 

Put your window assembly together 
You now have created all the parts for you window 
assembly; you now have to establish the grids and 
nested grids to make it work. 
Get back into the edit style dialog box 
Design>Window Assembly>Window Assembly Styles, 
select the 01Class style, RC>edit 

1. On the upper left select Primary Grid. 
2. Pick where it says default division and change 

this to Transom 
You can see the definition of Transom appears in the lower half of the dialog box.  You can have multiple 
cell assignments in the same grid - 
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3. Create a new Cell Assignment by picking on the new Cell icon in the middle left part of the dialog 
box. 

4. Create a nested grid by changing the default infill of the “New Cell Assignment” to Nested Grid 
5. Change the location to bottom (pick where it says top, bottom, a “…” will appear, pick this and 

deselect top 
Now you have a nested grid to work with. 

 
 
 
 
Stop for a minute and think – too much dialog picking can numb the brain.  Pick OK, OK, save your 
drawing. 
 
Add a wall, any wall about 12’ high from left to right about 15’ long in your drawing and switch to an iso 
view.  Add the Window assembly (tool palettes>DesignPalette>window assembly> select the new style 
from the properties palette   
 
Make sure the style says 01Class, the width = 5’, the height = 10’6” and the vertical alignment is set to 
sill height and has 0 for the value (for some reason on new installs this is set to something else and the 
window assemblies fall through the floor). 
Pick the wall in the drawing to place the window assembly in.  Your window assembly should look 
something like this. 

 
We created the “primary grid” to use a manual division called Transom.  Transom is what makes the 
mullion at the top of the assembly.  We then added another Cell to that we could divide the top and the 
bottom differently.  The next steps of the exercise will take us through defining that nested grid, and 
assigning yet another nested grid to make the kick plate.  Notice that even though we have a nested grid, 
we do not have two frames like the picture in the concepts.  By default when you create a nested grid, the 
nested grids frames are turned off.  Sometimes in complex styles you will need to use a nested grid 
frame.  For us, we will have to turn off the bottom frame to make way for the door.  One thing at time. 
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Assign the Rules to the nested grid 
Select the window assembly and Right Click, Edit Window Assembly Style. 
On the upper left, select the nested grid 
In the Rules field (the upper right part of the dialog box) add another cell and change the values to match 
the screen capture below. 

 
 
Highlight the next nested grid down and change the values to: 

 
 
 
 
Before you leave, go back to the primary grid on the upper left, find the frame, and deselect the bottom 
OK once to get back to the drawing and you should have something that looks like the illustration on this 
page. 
 
 
 

 
So that’s it, intuitive, easy to use interface! – Some more notes.   Were I to 
complete this, there are a few more adjustments to make: 

• I would find the frame that surrounds the kick plate and turn the bottom 
frame on.   

• Instead of using one of the template door styles, I would create a door 
style that had 0 thickness and width for the frame and use it – right 
now there are two frames around the door - the mullions of the window 
assembly and the frame of the door style.  

• If this were an external door, I would further edit the door style to show 
the sill on the appropriate side when seen in plan view. 

If I needed to model this, I would; 
• Create a polyline in the shape of the threshold in section. 
• Create a profile from the polylines. 
• In the window assembly create a frame definition that used the profile, 

then… 
• Either use overrides (probably) or set in the style definition to use this 

as a threshold. 
Play with this a bit before you close it out.  Right click modify it and change 
its width and height. In plan, grip stretch the swing of the door. 
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Other thoughts… 
 
If your office created frame schedules and frame type plans you can add window assemblies into a 
drawing without adding them to a wall, just return at the command prompt when it asks you for a wall to 
put it in.  Place all of your frame styles in plan, then create a paperspace view port that looks at them in 
elevation. 
Once you assign a style to an infill, you have access to that object with the right click menu. Sometimes it 
becomes difficult to select the window assembly or curtain wall because all  there is left of the object is 
the other objects filling in the cells/infills. – When creating these styles, try to keep at least some portion of 
the parent object visible so you have right click functions. 
 
 
The next exercise looks again at the parts, but focuses on editing styles in place, and using overrides to 
change different components. 
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Creating a Custom Window Assembly From Lines with Overrides 
 
Open …\LESSONS\WindowAssembly\WindowAssembly.dwg 
This drawing was created with the AecArch (Imperial) template and the layouts were deleted. 
Drawing has linework and wall placed in the drawing as well as some tweaks to a couple styles we will 
use in the exercise. 
 
Predefined for this exercise are the following styles 
Windows: 
WindAssmbly_DBLHung window style with the frame turned off 
WindAssmbly_Arched window style with the frame turned off 
Door: 
WindAssmbly_SingleFullLight  - Single Hinged door style with frame turned off 
 
These Styles will be used as infills for the window assembly 
 
Overall flow for this exercise 

• Create the window assembly from the lines 
• Save as a style 
• Establish all the different definitions within the style that we need to complete the window assembly.   

Create infills, mullions and frames. 
• Use the override functions to assign the parts created in the style to the window assembly using index 

numbers. 
• Edit in place mode, then save and write the overrides into the window assembly. 

 
Terminology 
Frame (the outer component of the window assembly) 
Mullion – Any of the internal divisions 
Infill – what happens inside each of the areas formed by the mullions and frames. 
 
RC indicates Right Click access to shortcut menu 

Create Window Assembly From Lines: 

1. On the Design Palette, Right click on the door/window assembly tool and select Apply tool 
properties to>Elevation sketch 

2. Select the linework in the lower left of the drawing, Enter, Enter, Enter 

3. Window assembly is placed in the drawing 

 
YOU ARE IN EDIT IN PLACE MODE!  The first thing we need to do is to save this as a new style. 

Save as a style: 

4. Select the window assembly, RC > Design Rules> Save to style. 

5. Pick the new button 

6. Give it the name 01Custom, Pick the OK button, and Pick the OK button again. 

You should be back in the drawing, the window assembly is now a style we can use. 

Add the window assembly to the wall: 

7. Use the Door/Window assembly tool to add this window assembly to a wall. 

8. In the Properties dialog box 

• Change Style to 01Custom 
• Change vertical alignment to bottom and 0.   
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• Width = 9’  
• Height = 10’6 

9. Select the wall and enter to place the window assembly 

 
(end result shown in WindowAssemblyD1.dwg) 
 

Establish all the different definitions within the style: 
Just as it is when you create a Door/Window assembly style, you create the kit of parts first, you need to 
do this for this style also.  
Create infills, mullions and frames. 
The next thing we need to do is to establish the parts we will use to finish the style.  The parts and pieces 
must exist within the window assembly style before we can use them as overrides 
 
We will need the following: 
Infills: 
“Door” based on the door style WindAssmbly_SingleFullLight 
“SideWindow” based on the window style WindAssmbly_DBLHung 
If you are ahead of the game, go ahead and create another infill called ‘top window’ based on the window 
style WindAssmbly_Arched 
 
We will also need some different frames 
A frame called ‘threshold’ that has a width of .25 and a depth of 6 
A frame W=2, Depth=6 
 
A mullion that has a width of 2 and a depth of 6 
A Mullion called “Plus1x” 
A mullion called “Less1x” 
These two last mullions will be used to align the mullions with the frames 
 
 

Establish Infill styles 
 
Select the window assembly, RC > Edit Style,  Pick the design rules tab 
On the left, select the infills 
Pick the new infill icon ( midway down below where it says ‘default infill’) 
This creates a new infill 
Give it the name Door  
Change infill type to Style 
On the lower right, expand door styles and highlight WindAssmbly_DBLHung 
 
Repeat this creating infill SideWindow based on the window style WindAssmbly_DBLHung 
 

Establish Frame Styles 
Select Frame on the left 
Pick the new frame icon 
Call the new frame ‘threshold’ and give it a width of .25 and a depth of 6 
Note if you wanted to create a threshold that was sloped, you could draw a closed polylines, create a 
profile and assign the profile to the ‘threshold’ frame definition here. 
 
We do not need to create a new 2x6 frame, we can just redefine the default Frame 
Highlight the default frame (top middle) 
Change the width to 2 and the depth to 6 
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Establish Mullions 
Select Mullions on the left 
Change the default mullion to Width = 2, depth = 6 
 
Create a new mullion with an offset (we will assign this to the interior mullions to get them to align with the 
frame, by default the mullions are center justified and the frame is justified to the outside of the lines we 
created.  Alternatively we could just give the default frame a +1x offset, but the overall width of the 
window assembly would then be 9’2…)  Note.  In general the offsets will work as shown below (plus x 
offset will move the mullion in the positive X direction ( to the right)),  but if the window assembly is placed 
backwards in the wall, then these directions will reverse themselves.  Also as you are creating the line 
work for the original window assembly, I believe that the direction of the linework is important.  Draw 
vertical lines from bottom to top and horizontal lines from left to right. 
 
Pick the new mullion icon 
Give it a name Plus 1x 
Width = 2, Depth = 6 and over on the right side, enter 1 for the x offset 
Repeat,  
Pick the new mullion icon 
Give it a name Less 1x 
Width = 2, Depth = 6 and over on the right side, enter -1 for the x offset 
 
Ok to return to the drawing. 
The frames and mullions changes we made to defaults are reflected in the drawing 
 
Drawing WindowAssemblyD2.dwg has the steps done to this point 
 

Create the overrides using the pieces we just made: 
We will first remove the mullion that goes through the door area with the  Merge Cells command 
In the right side viewport Select the window assembly RC>Cell Markers>1st Grid 
This gives us the ability to select the infill pieces 
Select the window assembly RC>Overrides>Merge Cells 
Select the bottom cell as Cell A, Select the cell immediately above it for Cell B 
This creates the space to put in the door 

Overriding the frames and mullions 
Override the bottom frame  - replace with threshold 
Select the window assembly RC>Overrides>Override Edge Assignment 
Select the edge at the bottom of the door area 
Hit F2 to show the text screen.  All the frame definitions are shown here.  Each has a unique index 
number.    
Type the index number of the threshold element at the command line. 

Override the Mullions to get them to move right or left. 
Repeat: window assembly RC>Overrides>Override Edge Assignment 
Select the internal vertical mullion to the right of the door area 
Enter the index number for ‘less 1x” mullion 
The mullion shifts 1” to the left 
 
Repeat for the mullion on top 
Repeat using the Plus 1x to move the mullions on the left to over to the right 1 inch 
 

Override Cell Assignments to add doors and windows. 
Note: after you add doors and windows, the door and window will be accessible directly in the drawing.  
When you right click on a door, you will not get the window assembly shortcut menu.  Make sure you 
select the window assembly not a door or a window after they are added. 
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Override the infill to add door 
Select the window assembly RC>Overrides>Override Cell Assignment 
Pick the cell marker where you want to place the door 
Hit F2 to see all the infill definitions in this style 
Enter the index number for the door type of infill 
 
Repeat adding the window infills to the sidelights 
 
Drawing WindowAssemblyD3.dwg has the steps completed to this point 
 

Write the overrides into the window assembly. 
We need now to turn off the cell markers and save these changes back to the style 
Note… 
 
Select Window Assembly RC> Infill>Hide Markers 
 
Select window assembly RC Edit in place 
Select window assembly RC Edit in place> Save Changes 
In the Save Changes dialog box, make sure the style is 01Custom 
Pick all available check boxes Transfer Merge Operations, Cell overrides and edge overrides to style. 
 
Pick OK 
 
Done! 
Drawing WindowAssemblyDone.dwg shows the completed drawing 
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Mass Elements, Groups and the Camera 

Mass Element Basics 
Mass elements are basic geometric solids 
The elements may be added, subtracted or intersected. This can be accomplished either through the 
mass group, or directly with right click Boolean function. 
May be ’extruded’ or rotated AEC Profiles (read polylines with an attitude) 
Can be ‘grouped’ together – see mass group 
 
Practical applications: 
Mass elements and groups can be used to design large commercial buildings 
They can be used to quickly provide “background” buildings for renderings, or master plans 
Can be used to solve problems such as niches, archways and things you just can’t do with a wall 
object; custom shaped counter for an kitchen island, half a column etc. 
as interference (subtractive) for walls 
or as a modifier for walls 
 
Drape Element; Draw the topolines at elevation and “drape this mass element over them to create a 
topo for Viz 
Works best if Plines extend past bounds of mass element 
 
Boolean; Right click on a mass element to add, subtract or intersect another mass element –no mass 
group needed. 

Basics 

 

Properties 
Watch the add properties for 
specify on screen Yes or No 

You can assign mass elements to a 
mass group with the properties 
page 

 
 

Style 
The style of a mass element is 
used mostly to control material 
assignments or hatch assignments 
in the drawing 
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Display 
Adjust the hatch, assign visibility to 
above and below cut planes (make 
above cut plane hidden and grey) 
to show overhead condition of 
complex mass element 

 

 

Display Rep Plan 
 

If needed override the cut plane in 
the plan representation 

Adding 

Tool, RightClick > Apply to: 
Only another mass element – Apply the tool properties to a mass element in the drawing 

Pick points 
How a mass element is added to a drawing is determined by the specify on screen option in the 
properties page. 
Specify on screen = yes, pick two corners a height and a rotation 

Specify on screen = no, pick insertion point and rotation 

Other 
Right click on any closed polyline, RC > Convert to > Mass Element  
Creates mass element from polyline 

 

Modifying 

ACAD modifying 
Standard Grip stretch OK 
Trim is not supported and will often break the mass element leaving only 2D lines – use RC trim 

RightClick Tools 
Boolean>: Union to create one mass element from 2. Subtract will prompt for the objects to subtract from 
the selected mass element. Intersect, just leave the common overlapping areas of the two mass groups 
Trim = pick two points and the side to remove, or you can specify 3 points if you want to trim out of plane. 
Convert to wall. This command does a 3D body modifier in one swoop. 
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Etcetera 

Internal Nodes 
Mass Elements have a node at the center of the shape at the top and bottom. Use this node to help place 
mass elements stacked on top of one another 

Mysterious 
Less than documented command to change a 3d element (solids) to a mass element 
Change a 3d element (ACIS solid) to a mass element. Type masselement at the command line, then 
type ‘convert’ at the command line.  Provide the element with a name, and you have a mass element 
in your drawing based on the solid you chose. You now have all the controls you have with a normal 
mass element, put it in a mass group for subtractive/additive functions, or anchor it to grids, Use it as 
an interference condition for walls etc. 
While ADT04/05/06 has the ability to convert a closed polyline directly to a mass element, you may 
find it useful sometimes to use the extrude command at the command line or off the solids toolbar 
(load ACAD menu) 
Create an ACIS solid by drawing any closed polyline and “extrude” it. 
Use extrude along another pline pick path instead of giving it a distance to extrude. 

Used to be little known 
Mass elements have the ability to display hatch. This is turned off by default R3, on by default R4.  
Masses are style based. You can create different styles to hold different hatches for like mass elements 
 

Mass Groups 

Basic 
The operator on the mass elements. Acts as the non destructive Boolean logic visibility cloaking 
device 
Boring by itself – it just appears as a marker until you right click and attach other objects to it 
Used to make one thing out of many masses or other objects 
The only thing that shows the result of making the properties of a mass element additive, subtractive 
or interfere 

Adding 
Just add from the massing palette 

Right Click > Model Explorer 
This is a very slick interface for working with Mass Elements and Mass Groups. Within this in 
Add elements, groups 
Modify elements/groups 
Copy and rearrange elements 

This is the only way to rearrange mass elements once assigned to a mass group.  Boolean logic (add 
subtract, interfere) is VERY dependent on the order as it shows up in the Model Explorer.  
Elements will only operate on elements above them in the tree. Drag elements in the tree with the left 
mouse button.  

Slices 
Are converted to space boundaries (which act like fake walls).  Space boundaries are then converted 
into walls. 
Or you do the mass model for looks and a quick study in VIZ. Then you draw the walls and skip all the 
in between. 

 
Alternative 458: 
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Put your mass elements in a group 
Assign slices to the group 

Convert the slices to polylines and the polylines to walls…. 

Camera 
Easy and fun…when creating a walkthough, there used to be a glitch that only one viewport could be in 
the layout or the avi would be empty – I have not checked this for R4 
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Slabs and Edges for Roof and Floor 
Slabs and Roof Slabs are twins, it is just that one got the upper bunk. The controls for creating them in 
the drawing are the same, the options for modifying work for either one. The only real difference is that 
you can convert a roof directly to roof slabs with a right click. 
 
If you have drawn spaces you can convert them to slab by right clicking the slab tool and “apply to 
space” 

Basics Roof Slabs 
Go as far as you can with a roof  
Then only if you really need to, convert it to a roof slab 
 

Properties 
 

Style 
Styles for roof slabs and floor slabs were overhauled considerably. Roof and Floor slabs now work much 
like walls in that they can have multiple components. Everything from the walls exercise applies. 

Display 
Be aware of where the cut plane is (is there a style override) and if a material is controlling the surface 
and cut (section) hatch of the slab 

Adding 

Tool, RightClick > Apply to: 

Pick points 

Other 

Modifying 

ACAD modifying 

RightClick Tools 
Shift, Alt do different things on grip stretch 

Slab or Roof Slab Edge Style 
2 Profiles goes into Roof Slab Edge Style (facia and soffit) which goes into Roof Slab tool properties. 
Insertion point is critical for these profiles – see the image in the edge style for the location expected for 
the insertion point of the profile. 

Etcetera 
 
Bpoly  to create 
Edges override, will be the same as roof slabs 
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Spaces  

(formerly Areas and Area Groups) 
 
OK, there is too much information here for a basic class, Spaces received an overhaul in the 2007 
release. The skinny of this is that they too a fairly simple object (space) and replaced a complex object 
(area and area groups). 

Way Finding within spaces: 
Spaces are a very useful tool in the Architectural Desktop toolkit. However, because there are so many 
parts and pieces involved, it is easy to get lost.  

Systems Thinking: 
Any time I have a new piece of software that I try to understand, I first attempt to apply systems thinking 
to the objects involved. Systems-thinking involves breaking down the components into a Kit of Parts and 
a Set of Rules. 2007 spaces are no exception, and fit into this thinking very well. The organization of this 
class follows this system based thinking 
 

Kit of Parts: 
2007 2004, 05, and 06 
Spaces (Styles) Areas 
Zones (Styles Area Groups 
Calculation Modifiers Calculation Modifiers 
Zone Templates Group Templates 
List Definitions Name Definitions 
Property Data Formats Property Data Formats 
Space Evaluations Area Evaluations 
Schedules and tags Area Schedule and Tags 
  
 

Set of Rules 
While there are no set rules concerning the order in which you do things… you can start with spaces and 
then add the zones or start with zones and then add spaces… 
You can start with spaces as a predesign tool adding spaces as simple placeholders to do participatory 
adjaceny analysis or you can do the schematic design and then add the spaces later, but… 
 
Add spaces to the drawing 
Use List Definitions for consistent naming of areas 
Add Zones 
Use Zone Templates for consistency 
Apply Calculation Modifiers as needed to spaces and/or zones 
Attach the zones and spaces together in logical order 
Create Space Evaluations and/or Schedules  
Area Evaluations Kit of Parts: 
 

Drawing Objects Style Tools Query Tools 
Space Calculation Modifiers Space Evaluation 
Zone Zone Template  Schedules 

 List Definitions  

 Property Data 
Formats 
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The Kit of Parts for the Area Evaluation consists of two drawing objects, four style based tools or 
modifiers and two different ways to query the information held by the areas: 
 

Space 
The Space object is the foundation of the Space evaluation (an export to excel). This is the object that 
holds the area and perimeter reported in the evaluation.  
Spaces can either be additive or subtractive, or combinations thereof. 

Basics 

Properties: 
The properties of a space contain the 
standard AEC object information such as 
the Name, the description, layer and 
style. Particular to the space are the 
ability to assign a Calculation Modifier to 
the area, or assign the space to a 
specific area group. 

Also the properties alerts you to the 
associative status of the space (is it 
aware of the surrounding walls?) 

 

Palette Tool Right click: 
With a right click on a space tool you can 
launch the autogenerate routine or convert a 
slab directly to a space object 

Palette Tool Properties: 
The palette tool provided for Spaces hold 
just the same information as the ACAD 
properties page, but allows you to set layer 
key, or overrides as well as set an external 
location for a tag that will be added with the 
space 
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Space Styles: 
Two important ideas are held in the space 
style. The first is the Space Name. This 
screen capture shows “Commercial Building 
Boma” This is a list definition. It’s purpose 
here is to keep the space names consistent 
(ie corridor always and never hall – or vice 
versa). Also on this tab are the default net 
usable and gross offsets base by style.  
 
I find it useful to have a couple different 
styles handy in the templates to control 
hatching. 

Display: 
More is told about the Space object by looking at it’s display properties: 
There are two main display representations for the area object, the Decomposed Representation and 
the Plan Representation. 

The Decomposed representation displays 
on screen the method for calculating the 
area of the space. This representation is 
useful for back-checking area calculations 
and is required in some regions to be 
submitted as proofs for building permitting 
purposes. 

 

The Plan representation is used in one way 
or another for the remainder of the 
representations for the Area object. The plan 
rep allows you to control the hatching and 
color of the boundary differently. 

 Note the space object is 3 dimensional as 
viewed in isometric mode it consists of a 
floor and ceiling plane. 

  
 

Adding 
There are many different methods for adding spaces to the drawing.  
Use the tools to add spaces prior to any walls as a space planning exercise 
Use the space Auto Generate tool to add spaces into a drawing that already has walls in place  

Tool, RightClick > Apply to: 
As with other ADT objects you have several more ways of adding areas if you right click on the Area tool 
and select Apply To…With the Area object you have three choices in the apply to flyout and each gives a 
slightly different set of subcommands. You can apply the area tool to Areas, Linework and AEC Objects 
or Auto-Detection. 

Apply to: Spaces 
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When you apply tool to Spaces, it just takes what ever setting are in the tool properties (not the ACAD 
properties) and applies them to the existing space(s) you choose in the drawing. This includes style 
height etc if set in the tool properties 

Apply to: Linework and AEC Objects 
 is for polylines and space objects. You can use any other AEC objects, such as a roof, to get the space 
of a dormered area at any given height, but in general, I find the space object may already exist, and if I 
want the functionality of the areas, it is just a few steps away. This is NOT the command to use on walls, 
that command is.. 

Apply to: Auto-Generate 
When you use this command it behaves much like a hatch. Be careful that you are zoomed to the extents 
before launching the command. If you are zoomed into a single room it probably will not find the 
boundaries if you zoom out after you launch the command. 
Also be aware that there are 3 options for generating spaces 

 Of these I use Walls Only about 98 percent of the time. 
If this is set to Walls, Lines, Arcs, Polylines and circles, heads up that it may take a *Long* time to find all 
the possible borders in the drawing. 

Tool, RightClick > Style 
Just opens up the style manager filtered to the styles available in the drawing. 

Some tips: 
You can get polylines by changing to the reflected display configuration, setting the cut plane above the 
windows and doors, turning of the ceiling layer if there are ceiling grids and then using the BPOLY 
command to pick the rooms in the plan. 
If your walls are center justified you can use the diagnostic configuration to snap to the graph lines of the 
walls. 

Modifying 

ACAD Modifying 
Copy, cut, paste functions all work fine. However if you need to cut one do not use the standard ACAD 
trim command, use the trim or divide off the right click menu instead. 

Grips. 
Standard grip stretch functions apply – no special grip stretch like slabs or stairs. If you need more points, 
use the Right Click > Edit Vertices and watch the command line for 
Pick vertex to add or shift-select to remove: to allow you to add or remove vertex points. 
The side grips have  the added ctrl functions: 
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RightClick Tools 
Once the basic spaces exist in the 
drawing you can use the right click menu 
commands to modify them. 
Join will make two separate areas report 
as one value – even if they are not 
touching.  
Subtract will make a subtractive area 
inside the selected area. The subtracted 
area will be taken away from the area.  
 

Zones (formerly Area Groups) 
Zones are the way to collect Spaces together to sort and organize the Spaces in the building. If you are 
using the Evaluations, you can then pick and choose which Zones to include or not include. 
Groups styles can be defined to be able to include other groups.  
 

Basics 
 

Properties: 
The Properties of the group are not that different 
than those of the Space.  
Of note is the Use Name Definition. This lets you 
assign a name definition for all Spaces in the 
group. A Name definition is just a list of names. 
This is handy if you have clients or building 
departments that want a consistent naming 
convention and a storage are is not Storage on 
one plan, Closet on another and Unoccupied on 
a third. 

 
Palette Tool Properties 
The Zone Tools are again not that different from 
the space Tools, but you can assign a name 
definition to the Zone as it is created. That is 
enough reason to perhaps copy this tool on the 
palette. 
You can also tag groups if you want to, I have 
not found any reason to create one but I guess 

 
Zone Styles: 
Also like Spaces, there is not much in the group 
style other than classification and display control 

Display: 
There is more in the Zone Display than anywhere else. Again, mostly in the plan display. The default 
settings are fine for most things, but you should understand what the subcomponents are. 
 

Plan Representation 
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Entity is the small box along with a surrounding 
line on all Spaces that are assigned to the 
group.  
Hatch if it is turned on will hatch all Spaces 
assigned to the group – only if the “Entity” is 
turned on. Otherwise it will hatch only the small 
marker that is the handle of the group. 
The Space and Group Connection lines will just 
show a visible link between the attached parts 
and pieces. 

 The Other tab of the plan display controls how 
the text appears next to the groups 

Adding 
When you add a Group, you are only adding a marker. For those of you familiar with Mass Elements and 
Mass Groups, the idea is the same. An Zone is nothing without something attached to it. 
You can add entire hierarchies of groups at one time using the Zone Templates – see below. 

Modifying 
There is not much to do with ACAD to an Zone except move, copy and paste and all these work fine. 

RightClick Tools 
 Right click tools are pretty limited to attaching or detaching 

Space and Zones from the selected group. The Zone Layout 
will just modify the location of the group in the layout. 

Zone Templates. 
Group Templates are just a collection of Zone Styles stored in yet another style.   
 

Within the Zone Template style definition, you can Add, rename and delete 
groups by right clicking on a group in the left pane of the dialog box. (not obvious, 
but reinforces the idea “When in doubt, Right Click”).  
When you add an Zone Template, all the Zones are added at once ready to use 
(assign Spaces to). 
 

 

Calculation Modifier Styles 
A Calculation Modifier is a mathematical expression you can assign to an Space or Group in its properties 
page. Assigning a calculation modifier will let you pull two values from the Space. The Base Space which 
is the sum of all the additions and subtractions of the Space and the Calculated area which is the result of 
the function you have assigned via the Calculation Modifier style. When you create a Calculation Modifier 
style you can decide to apply this to the perimeter or the area of the object (Space or Zone) If you leave 
both of these selected, you will see the Data on the right just read Value. Normally you will be creating a 
modifier to one or the other, so pick the Apply To tab and set that first. 
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This is an example of a Calculation modifier you could apply to gross occupied area to get the value for 
the width of stairs. The function takes the base area (applies to area not perimeter) and then assumes an 
occupant load factor of 100 SF / occupant. The  
Rules: 
When you add a variable on the left, you can use it on the right. As you enter the value of the Variable on 
the right in the expression, this is CaSE sEnsiTive. Otherwise any expression you create will be applied to 
the area. Simple expressions using + - / and * are fine. 
Odd: 
You can only have one calculation modifier per space or Zone. While at first limiting it is easy to copy 
Spaces and groups if you need more than one kind of modifier. 

Name Definitions 
A name definition is just a list of names that make naming the Spaces assigned to a particular group 
consistent. A name definition is assigned to an Zone in the properties page. Once assigned, any Spaces 
that are attached to that group will have the drop down appear and list those names. This functionality will 
not prevent you from typing in a name that is not per the definition, but just provides the drop down that 
lets you use the list. 

              

Space Evaluations 
OK, all of that is fine, and all the parts have their place in creating the Space Evaluation. The Space 
Evaluation tool is on the same documentation palette as the Space and Zone tools. When you pick this 
tool, a new dialog box pops up that allows you to get visual feedback concerning the Spaces simply by 
selecting them on the left. Here you can isolate what Spaces and groups you want to write out to the 
excel sheet. The evaluation Options tab on the lower right controls how and exactly what the information 
will be written out to the excel or text file. 

        
You control the Information for both Spaces and Zones here, selecting if what parts you want to include in 
the evaluation: The Name, Description (from the Properties), A small bitmap image of the Space or Zone 
and what details about the Area or Perimeter to you want to push out to the excel sheet. 
The Second tab just gives you control over how you want the images to be captured – you can set 
Display configurations that have solid shading so you see a solid image (use Presentation Configuration if 
you want this – already standard in the ADT templates). 
The Third tab controls the format of the values written out to the spreadsheet 
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Here you assign a Property Data Format that controls how the value will be formatted in excel. While this 
is nice if the excel sheet is the end product, formatting cells beyond a simple number can be painful if you 
need to manipulate these values later.  
The last tab is the template that will be used by the evaluation function The templates for the evaluations 
are stored in a subfolder of the standard template folder. 
C:\Documents and Settings\All Users\Application Data\Autodesk\Autodesk Building Systems 
2004\R16.0\enu\Template\Evaluation Templates\... there are several for both text and excel format 
evaluation. 
If you cannot access (it is grayed out) the evaluation export buttons at the lowest right, it is because you 
have not assigned a template yet. Pick the export button and voila! 

Space Schedules and Tags 
While the Space evaluation is useful, there are times when you cannot get the base functionality to do 
everything you want to do, and other times when you want to keep the information in the drawing instead 
of an Excel sheet. In 04/05/06 the schedule table got a very thorough working over and you can now do 
quite a few things with the schedules that compliment the Space and Zone evaluation function. 

  
This table shows how that you can do other 
things like establish your occupant load 
factor using Spaces 
 
This table is set up like this: 
There is a property set definition 
OccupantsStyleBased that looks like the 
image on the next page 
 
 
 

 
 

 
I made this style based assuming I would create Spaces that were close enough to assign a variable 
OccupancyFactor and store that value in the style of the Space. I made this just a manual property so that 
it can be manually set from style to style.  
The BaseArea is just the area of the Space object. I did not use the one already provided because this 
value already has a property format of BOMA Area. This property format applies the NAU prefix and SF 
suffix to the number and I find that I like to keep numeric values straight forward in case I need to use the 
value in a Formula property (as I do here). applies to Space styles that has two values in it. 
The Formula is as per above assuming the base area will be divided by the occupancy factor. 
Some notes on Property formulas: 
You will get odd values in the schedule if the occupancy factor value is not set (or 0) once all the styles 
get assigned a numeric value for the OccupancyFactor things will be set fine. 
If you are doing complex formulas, you must use the buttons on the property creator, you cannot just type 
this in. I have found that this is very finicky and that sometimes it is easier to recreate an entire property 
rather than modifying an existing formula. 
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This schedule definition looks like this. Even though I keep the raw data that exists in the property 
definition as a number, I have no hesitation to reformat that value in a column in a schedule. Here the 
OccupantsStyleBased:BaseArea –is Standard as set by the property, but overridden as an Space 
property format in the table that gives me the SF at the end of the value. 
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Other thoughts 
There are two ideas promoted by about how to use Spaces and Zones Top Down and Bottom Up. Top 
Down means you put the groups in the drawing first via a Group template. Assign Name Definitions to the 
Zones And then assign the group as you add the Space (properties page) so you have access to the 
name definition list. While this allows you to take advantage of the Name definition list, I find this way 
annoying. I prefer to make all the Spaces I need and then assign them to groups as makes sense. I like 
this because when I am putting Spaces into the drawing, I find it easier to do If there are not a lot of other 
selections getting in the way of grip stretching. – yes I can get rid of the groups with display control, It is 
purely personal preference. 

BOMA CALCS: 
Before I say anything about BOMA Calcs – I must say get the publication. This is a legal document and 
any terms I use in this paper or in class, must default to the definitions outlined in the official BOMA 
document. Interestingly – you cannot download this from the BOMA site directly but must order it – but if 
you go to the ANSI site you can download it in PDF format. OK that disclaimer done… 
 
I like to have one group template that has the following Zones in it. 
Rentable, Usable and Building Common. You will need these areas of the building to create the BOMA 
calc and get the Rentable to Usable ratio, so it makes sense to me to have a group template already set 
up to show these values. 
I also like to have my group styles hatched differently and hatch turned on so I can see what they are 
doing in the drawing readily 
 
As much as I would like to have the schedule object do everything in the BOMA calc for me, I cannot see 
a way to have the schedules even with the formula based property set do the kind of calculations BOMA 
requires without doing a bit of VBA coding which I don’t do. Basically what you need it to is look at all the 
subset of attached groups and select one and divide its area by another. (or in terms of scheduling, take a 
value from one object and operate on that same value of another object.) Regardless, this is fairly 
painless to do in Excel if you watch your property Data Formats and are not sending a bunch of format 
code to the excel file. Set the Spaces and Zones up in a way that makes sense and then use the 
schedule function to push the data (Rentable, Usable and Building Common) for all floors of a building  
out into and excel file. Create a couple function cells and you are done. 
 
Be creative in your use of objects when you are generating your Spaces – use the bottom view to get the 
sketch representation of the walls. Use the reflected display config and use Bpoly to generate polylines, 
adjust window and door/window assemblies to get a single line so you don’t have to draw around all the 
windows.  
 
Building Systems: 
Use the Spaces and Zones on the 2D elevations to quickly find the area of wall/glazing. 
 
Apply a calculation modifier to the floor area to give you rough energy calcs based on watts/sq ft. 
 
 

Creating an Occupancy table 
The following was written for the 2004 software it still mostly works, but anywhere you see Area object 
think space and where you read Area Group – think Zone 
Per the student’s requests in the class, this section has been added to the original handout 
For a dataset you can use either my dataset, or any drawing with a couple areas it in that are different 
styles. – You will be using the styles to assign the occupant/SF variable, so make the area styles names 
make sense with the occupancy table. 
Just one last note: 
I am using Autodesk Building Systems to create these datasets. I have been as careful as I can be about 
not populating these drawings with anything from ABS. I have hacked the registry so these modules do 
not load. However, I cannot test to see if there is anything in them. If you get a proxy message about ABS 
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not loaded on your machine, be careful with the drawings, and don’t copy parts from these drawings into 
your working drawings. I hope this will not be the case, if it is, let me know and I will need to recreate 
these from scratch. This is not a major disaster, it is just a display representation that ADT does not 
understand. There are no Objects from ABS in these drawings. 
 
If you are using my dataset, then open the project navigator 

 
Start in the StartOccupanceExercise Drawing. The OccupancySchedDone has the end result of the 
exercise in it. 

 
 
There are four main steps to creating this schedule table. 
Create the Property Set Definitions 
Create the schedule table style 
Apply the property sets (Add the schedule data) 
Add the table to the drawing. 

Create the Property Set Definitions and Data Formats 
There are 5 columns in the schedule table, so we will need to make or find 5 property sets to create the 
schedule. I have inserted the Area & Zone Styles - BOMA (Imperial).dwg from the styles folder in the 
content directory … enu\Styles\Imperial so I already have some property set definitions to work with that 
apply to areas and Zones. The others I will create here. 
 
Open the StartOccupancyExercise.dwg from the project navigator. 
Format>Style manager>Documentation Objects>Property Data Formats 
Create new, rename to SinglePrecisionNumber set values as below 

 
You may want precision to 0.0 – but I am putting it to 0 to show what I skipped in class. Normally for 
my building department I would show 1 decimal point. 

OK back to style manager. 
Move down to the next category, Property Set Definitions 
Create new, rename to OccupantsStyleBased 
Pick Applies To, make it apply to Styles, and only Areas 
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Create new property with the  button, Set source to the BaseArea. Use the 
default name BaseArea. – let the format of this stay at standard so you can have a few decimal points to 
work with.  

If you have inserted the BOMA drawing noted above, you will already have a BOMA_AreaStyles with 
this value, but it is formatted differently. I like to keep my PropertySetDefs and such separate for 
different uses, so I just create a new one here. 

Add another property - manual and name it OccupancyFactor. 

 
Set the Type to Integer and the format to SinglePrecisionNumber (could be Standard as the format is 
integer should keep the decimal points at bay) – set the default value to 100. 
 

Add yet another Property using the formula based property definition  
Rename this to OccupancyLoad 

 pick OccupantsStyleBased>BaseArea 

Pick the / symbol,  
 
Pick OccupantsStyleBased>OccupancyFactor 
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Should look like this: 

 
do not type these in, picking the property below and the / from the toolbar establish functions and 
relationships that are behind the scenes that you will not get from typing these values in.  

Also – a side note – I have found that if I need to modify a formula based property sometimes the 
formula stops working. If I recreate it from scratch, it will work. I think this has to do with some of the 
behind the scenes functions getting left in the property even after I have erased or replaced something 
in the formula, but cannot quite be sure, I have not tracked this down.  

OK back to the property set definition properties (not style manager) and set this formula based 
properties format to SinglePrecisionNumber 
 
Add another Property (automatic) and select Name as the property source, set the format as Case Upper 
if you have it in your drawing otherwise leave it as standard. – I do this because the name might be 
different than the style. For example the style might be “OfficeSpace” and get the 100 SF/Occupant 
factor, but there may be Admin offices, Open Offices and other individual areas with different names of 
the same style, but will all have the same occupancy factor.  

– Note that you are pulling a property from an individual area, but are applying the property to the style 
based property set. This is OK, and I do this often, as well as working it the other way – you can pull 
some information from a style into an Object based property set if needed (for a “type” schedule for 
example). 

If you are mostly working with multistory buildings and the Project Navigator, Add Another Property using 

the Project based button  Select Level ID as the source. 
 
So, backcheck, the Property Definition should look like this, more or less 

 
 
OK,OK back to the drawing and save because you have done a bunch of work and don’t want to lose it. 
 

Create the Schedule Table Style 
Format>Style Manager>Documentation Objects>Schedule Table Styles 
New, and rename to Occupancy Table, RC>Edit 
Applies To tab… Clear All, select only Area 
Columns tab: 
Pick Add column, select OccupantsStyleBased>Name (if you are using my dataset you have to scroll way 
down the list). Heading and Data Format are fine as is, OK back to table style properties 
 
Add columns OccupantsStyleBased>…  Floor and Base Area – just as they are, no change to heading or 
data format. 
 
Add column OccupantsStyleBased>>OccupancyFactor, change heading to SF / Occupant (with spaces). 
Pick the Override Cell Format and put a value of 1.25 in the Fixed Width Column to force the header to 
word wrap. 
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Add Column OccupantsStyleBased>[BaseArea]/[OccupancyFactor]. Change heading to Occupants and 
pick the Total check box below the override button. 
Verify this format is set to SinglePrecisionNumber. 

You could have left the format for property [BaseArea]/[OccupancyFactor] as standard, and then 
overridden the property here in the schedule if you wanted. The important thing is to have all the 
values used in the formula based property as the same type of value so [BaseArea] will return a REAL 
number (decimal) and [OccupancyFactor] is set to Integer, so dividing these should not be a problem, 
but will return a REAL number which then you tell the property Occupant load to reformat as a 
SinglePrecision. You want to make sure that you don’t take a value like Base Area out of the BOMA – 
NRA property set because it has a different property Format that includes a Character prefix and suffix 
and will present data to the formula that it will not understand. 

 
While you are in the style manager drag the schedule table style onto a toolbar – this will only be useful 
for this drawing, but creating tools is a completely different lesson. 
OK back to the drawing and Save 
 
 

Add the schedule table 
Change to the model tab layout (so you have the Medium display configuration and can see the 
schedule) 
If you did not make a tool, Hit the door schedule tool, then move over to the properties and use the drop 
down to select the schedule table style you just made.  

 
 
Type ALL at the select objects prompt, place the schedule table 
Everything is ? because the Property Set Definition has not been applied to any of the Area Styles in the 
drawing 

Apply Property sets to all Area Styles 
You can do this from the drawing by right clicking on each space and choose Edit Style off the pop up 
menu, but I will do this in style manager because it is faster. 
 
In style manager, expand documentation objects and Area Styles. 
Pick the Vertical Area Style, RC>edit 
On the general tab, pick the property set button and then the add button 
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pick the Occupants Style Based and then change the OccupancyFactor to 10000. I do this to make this 
essentially an Accessory space that will return a 0 for occupants and does not get included in the 
Occupancy calculation. – repeat this for the Corridor and OfficeCommon Area Styles -  Bathrooms and 
other non-occupied. 

OK, this dataset was set up for the BOMA calcs and not necessarily with the styles I would use to do 
this, but you get the picture. 

Repeat for the OfficeArea style giving it a 100 Occupancy Factor 
Repeat for BuildingCommon, giving it a 300 Occupancy Factor 
OK back to the drawing, select the schedule table RC>update – id should now look something like…the 
image on the next page. 
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Structural Grids (and Ceilings) 
Anchor grids within grids 
Grids can be clipped  
Grids have no true plan rep (watch osnap around the ceiling grids) 

Basics  
Structural grids are limited, but then again, so is most of what we do as architects with grids. 

Properties 

Graph lines and clean up radius 

Style 

Display 

Adding 

Tool, RightClick > Apply to: 

Pick points 

Other 

Modifying 

ACAD modifying 

RightClick Tools 

Etcetera 
Anchor grids within grids 
Ceiling grids can be clipped  
Ceiling grids have no true plan rep (watch osnaps around them) 
SN will center the grid in the space – after you pick set boundary and the command is asking for an 
insertion point, type SN at the command line to center the ceiling grid.  It will provide a default rotation 
based on the first segment of Polyline, or the space set to bound the grid. 

Be aware that when you place a ceiling grid with a boundary, the grid may be larger than the space or 
polyline that creates the clipping boundary (It will most likely be larger) – grip stretch the ceiling grid to the 
smallest size you can get away with BEFORE you center it in the space. 
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Structural Columns, Beams + Braces 
Each of these objects uses the same style – It is only how you add the object that determines the layer 
key and orientation of the object. – keep this in mind when you need to rotate them around a node on a 
structural grid. 
 

Basics  
 

Properties 
Same as it ever was, properties 
control location (justification, 
elevation) and overall dimensions 

 

Length is really height for a 
columns 

 

Offsets let you “trim” back the 
structural member (beam) from 
another column that you might use 
as pick points to create the beam. 

 
Style 
All styles you get from the structural 
catalog will be a shape extruded 
through the length of the member. 
 
More complex shapes can be had 
from the Content Browser Design 
Tools catalog,  or the Content\Styles 
drawing ie bar joist, columns with 
wraps etc. 
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Display 
Structural members have the most 
display reps of any object – if the 
section does not show enough detail – 
change the Section_Elevation display 
set to use the Elevation Fine detail (is 
set this way by default). 
 
Watch out for Columns and Beams 
and Braces – they too do not have a 
nice plan display rep – be careful with 
osnaps around them 

Display Rep Plan 
If you want a single line – turn off the 
components – or use the logical 
representation instead 

 

Adding 

Tool, RightClick > Apply to: Beam or Linework 
Use the “apply to” to convert lines to beams 

Pick points 
If you add beams in Iso mode, you can set your osnaps to NODE only and snap along the tops of the 
columns in the drawing 

Other 

Modifying 

ACAD modifying 
Trim, extend work. 

RightClick Tools 
Edit Trim Planes (do in ISO view) allows you to edit the trim planes in a graphic way rather than through 
the dialog box 

Etcetera 
Make sure to look in the styles folder for more Member styles – there are two drawings installed that have 
complex member styles. One for Bar joist, and the other for column wraps and such. 
 
Watch out for Columns and Beams and Braces – they too do not have a nice plan display rep 
 
Separate columns from a column grid by releasing the anchors (right click). To place in separate 
drawings. 
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Sections and Elevations 
Section and Elevation one sheet 
See also Callouts section 

Basics  
There are 3 main ideas behind sections and elevations – or rather 3 completely different ways to 
generate a section of the building model. A 3D Section/ Elevation, A 2D Section/Elevation, or a Live 
Section. In all cases the section is inherently linked to the section line that generated it. This chapter is 
primarily concerned with the  

 
Do not associate hatch 
Hatches merged become lines (drastic performance hit) 
Control visibility by style – everything is in the display properties 
 
While some architects have a style that lends itself to using the  

Properties 

Style 
The 2D Section elevation style contains two main tabs the Components tab and the Design Rules tab. 
The components tab allows you to create components of the style that you can assign display properties 
to. The Design Rules tab works in conjunction with the  

Display 

Adding 

Tool, RightClick > Apply to: 

Pick points 

Other 

Modifying 

ACAD modifying 

RightClick Tools 

Etcetera 

Mysterious 
Merge again after refresh to save previous changes (refresh 2D section will kick out all “Linework> edit 
operations into a separate 2D section right on top of the original – merge the two sections) 
From the newsgroup 
Hi Cameron, 
    Here's something to try... it seemed to help me. 
  
Whenever CreateHLR or 2d section/elevations are calculated we do some postprocessing to remove 
overlapping segments. When there is lots of complex linework, however, this process can produce 
errors. You can turn this off by editing the following registry setting: 
  
HKEY_CURRENT_USER\Software\Autodesk\AutoCAD\R16.0\ACAD-
XXX:XXX\AEC\4.0\AecGuiBase40\Preferences\HLRBypassLineCleanup 
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Change this setting from 0 to 1 and try running CREATEHLR again. Does that help? 
  
Chad 
Hi Cameron, 
    Well, I'm glad you looked at that because I thought we weren't using that setting anymore. We did a 
bunch of work to reduce tolerance problems when generating 2d sections & elevations. 2d sections 
and elevations do not use HLRPRECISION at all. It appears that CreateHLR is still using 
HLRPRECISION as a factor when it shouldn't be so setting that to 1 is probably a good idea for 
everyone to do. It's been this way since ADT3 and I don't recall many other issues with CreateHLR so 
that's why we didn't realize it was a problem. Let us know if you notice any regressions, we'll 
investigate it further and probably remove the variable for the next release of ADT. 
Thanks! 
Chad 
  "timberdesign" <admin@timber-design.com> wrote in message 
news:f18ccf9.1@WebX.maYIadrTaRb... 
  Hi Chad, Thanks for getting back to me.... I have made the suggested registry change and can notice 
little change in the output. However, I decided to fidle ;-) with one or two of the other settings. I had 
high hopes for HLRPRECISION and cranked it up and up and up from 5000 to 40000 but with little 
gain. Finally, I set it to 1 'et voila' spot on, as far as I can tell from limited testing. What have I done 
????? can I leave it like this without ill effect? and should accuracy improve with lower settings? Look 
forward to hearing, hoping it is solved :-) Many thanks, Cameron. 

 


